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Introduction
This Getting Started Guide forms part of the documentation supplied 
with each UniSim Heat Exchanger program:

• UniSim® Heat Exchangers User Guide
• Getting Started
• Program Reference Guide.

The UniSim® Heat Exchangers User Guide is supplied as a pdf 
document with the installation media.  The Documentation media 
contains the UniSim® Heat Exchangers User Guide and all the other 
documents.  The UniSim® Heat Exchangers User Guide is generic to all 
UniSim Heat Exchanger programs.  The Getting Started and Reference 
Guide are specific to each UniSim Heat Exchanger program. 

The Getting Started Guide assumes you have access to an installed 
copy of the UniSim Heat Exchanger program, and takes you through 
some example cases provided with the program, so you can get a feel 
for it capabilities.  It also describes how you can run a set of QA sample 
cases, and compare the output files with sample results, to confirm that 
the operation of the program is as it should be.

More detailed examples, showing how you can use the program to 
solve typical problems, are provided in Appendices to the program 
Reference Guide.
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Technical Support
Technical support is available by phone (1-403-509-1379 or 1-866-392-
8748 toll free in North America), fax (1-403-216-2801).

E-mail support for customers with a current support contract for their 
product is available.

On-line support can be accessed via http://www.honeywell.com/ps.

When contacting us via email or phone, please include in your 
message:

Your full name, company, phone and fax numbers.

The software version you are using (shown in the Help menu, About 
UniSim…).

A detailed description of the problem (attach a simulation case if 
possible).

Honeywell Email Address

Global unisim.support@honeywell.com

North America unisim.support@honeywell.com

Latin America unisim.support.lar@honeywell.com

Europe, Middle East, Africa unisim.support,emea@honeywell.com

Asia Pacific unisim.support.ap@honeywell.com
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1 Getting 
Started 
Included with your UniSim® Plate-Fin Exchanger Modeler 
(referred to as UniSim® PFE) software are a number of 
example input files that can acquaint you with the program. 
These cases are fully defined and ready to run. You can simply 
open the cases and run UniSim® PFE to see the type of output 
that can be generated. This Getting Started will step you 
through one of these example cases, as a brief introduction to 
the UniSim® PFE architecture, input options and available 
output information.

A complete set of results for the sample input files is provided 
Chapter 2 - QA Examples in a separate location for Quality 
Assurance purposes. See Chapter 2 - QA Examples for details.

Chapter 7 - Examples, of the UniSim® PFE Reference Guide 
consists of a set of tutorials that you can follow to build different 
types of UniSim® PFE examples. By working through these 
examples you will familiarise yourself with the software data 
entry methods and the various input and output views.

Before looking at and running the sample input files, it is 
important for you to know that UniSim® PFE can perform 
several main types of calculations. When you begin modelling 
your own exchangers you will have to make the choice as to 
which calculation type you require. The examples in the 
UniSim® PFE Reference Guide provide greater detail on the 
calculation mode options, but for the purposes of this Getting 
1-1
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Started, they are briefly described below:   

1.1 Example 1
In this first example you will take a brief look at how an existing 
dataset can be reviewed, run and the outputs accessed.

1. Start UniSim® PFE. This can be done several ways and will 
depend on how you set up your desktop. However, the two 
main ways are: 
• Clicking on the Start menu then Programs, 

Honeywell, UniSim Heat Exchangers Rxxx, and 
UniSim PFE.

• Selecting PFE from within Windows Explorer.

Once the splash screen has cleared you will see the main UniSim® PFE 
window and over the top of this is the Welcome dialog screen see 

Calculation Types

Design Engine For designing a heat exchanger to meet a 
heat load duty and pressure drop limits, which 
you specify.

Simulation 
Engine

Determines the heat load, pressure changes 
and stream outlet conditions that will occur 
with a specified exchanger, with given stream 
inlet conditions.

Simulation 
Engine - 
Thermosyphon 
Mode

Determines the flowrate and duty of a 
specified exchanger, operating as a 
thermosyphon. You specify the head of liquid 
during flow through the exchanger.

Layer by Layer 
Engine

This is like Simulation, but is performed for 
every layer in the exchanger, rather than for 
every stream.

Crossflow Engine Simulation of crossflow exchangers, with one 
or more passes.

Crossflow Engine 
- Thermosyphon 
Mode

Same as for the Simulation engine - 
thermosyphon mode but with at least one 
crossflow stream.

There are four “Engines” within UniSim PFE - Design, 
Simulation, Layer-by Layer and Crossflow.  These mostly use 
the same common input data and output formats, with 
engine-specific data where required.
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Figure 1.2. From this screen you can select to create a New file or 
open an Existing file. If you have used UniSim® PFE previously, the 
project file you have worked with will appear in the Recently Used 
Project File list, making it easy to get back to files you were recently 
working on.

2. Select an Existing file; press the Existing button.

3. You are presented with an Open File screen. To open the file 
for this Getting Started, go to the 

 Figure 1.1

 Figure 1.2
1-3



1-4 Example 1
C:\PROGRAM FILES\Honeywell\UniSim Heat Exchangers 
Rxxx\UniSim PFE\Samples directory. 

(This is the default directory, the exact location may be different 
if you changed the UniSim® PFE destination directory during 
installation.) See Figure 1.3 for the Open File view.

 Figure 1.3
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4. For this example, select the file QPFE1.PFEI. You will know 
when the file has been loaded because the Exchanger 
Diagram will appear within the UniSim® PFE window. .

Once UniSim® PFE has started you can open other files by 
selecting Open from the File menu. To use the Welcome 
screen again, select Start Project from the View menu. 

 Figure 1.4

If you cannot remember where a file is located, there is a 
Find File utility to help you. Select Find File from the File 
menu or use the keyboard shortcut by pressing 
<CTRL>+<F>.
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1-6 Example 1
However, in either case you can only have one project active at 
any one time. For most common activities there are short-cuts. 
To open a file you can either click on the Open icon or use the 
keyboard shortcut by pressing <CTRL>+<O>. 

Now look a bit closer at the project file you have opened:

1. Click on Input in the menu bar.

The Input menu shown below gives access to all of the input 
data. The menu itself is divided into the different types of data 
you need to describe the heat exchanger and the conditions 
under which it will operate. These include different aspects of 
geometry, process conditions and physical properties.     

2. Select the Geometry input form (see Figure 1.6) and you 
should see inputs which give the exchanger metal, number 
of exchangers in parallel, orientation and so on. This screen 
is typical of most screens in that the data is entered either in 
a text box or via a drop- down menu. The drop-down menu 
shows a list of possible inputs where you simply select the 
appropriate item.

 Figure 1.5

You may see minor differences in the screens in your version 
of UniSim® PFE, compared with the figures in this manual.

Open Icon
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3. Now look at process data by selecting Process from the 
Input menu or by clicking on the Process icon. 

Figure 1.7 shows another form of input screen where the input 
items are arranged in a spreadsheet format. If the data do not 
fit on the screen, a scrollbar allows you to access the other input 
items. The spreadsheet view is used when data are required 
several times, in this case for each of the streams in the 
exchanger. 

 Figure 1.6

If at any point you are not sure what input you want or 
something is not clear, you can press <F1> and get context 
sensitive help. If you select the Exchanger Metal 
entry and press <F1> you can see a list of all the metals 
supported.

Process Icon
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1-8 Example 1
4. Finally, you will look briefly at the physical properties input 
by selecting Physical Properties from the Input menu or 
by clicking on the Physical Properties icon. 

The initial screen, Figure 1.8, shows the top level information 
about each stream.

Depending on the type of physical property data you are 
working with, you can either enter the property data for the 
stream directly or enter data for components and allow 
UniSim® PFE to perform vapour liquid equilibrium and mixture 
calculations. All of the physical property data, are managed 
through this screen. 

 Figure 1.7

Physical Properties Icon
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Since this is an existing case all the necessary data have already 
been entered.

5. Run UniSim® PFE by doing one of the following:

• Click on the Run icon in the Toolbar;
• Select the Run menu and then Calculate All;
• Press <F4>. 

UniSim® PFE now displays a status window that reports 
progress of the run.

When the run completes there are three possible outcomes and 
corresponding outputs will be displayed.

• Successful run with no fatal errors and no warnings - a 
screen showing the Results Summary is displayed;

• Successful run with no fatal errors but with one or more 
warnings - the Results Summary is displayed together 
with a list of the warnings associated with the run;

• Failed run due to fatal errors - the Error Log is shown 
with a description of the errors that have occurred.

In this case you should see the Results Summary which shows 
the given stream inlet conditions, and the calculated stream 

 Figure 1.8

Run Icon
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outlet conditions. See Figure 1.9.

There are many different outputs that can be viewed from the 
Output menu, as shown in Figure 1.10.

 Figure 1.9
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Notice from this menu the different types of output available. 
The first group of outputs are all special ‘Windows’ outputs, 
that is to say they are special views of the data typically in the 
form of graphs or tables. 

 Figure 1.10
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6. Select Temperature Profiles from the Output menu to see 
a table of the stream temperature (Figure 1.11). This could 
alert you to any unusual behaviour.

You will see there are other sets of outputs under the Output 
menu. The final group of outputs are files generated directly by 
the calculation engine. They are all text files and contain 
different aspects of results generated. Of these, the one that 
you are most likely to use is the Lineprinter Output, which 
contains all of the important information, should you want to 
retain output.

 Figure 1.11
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1.2 Example 2
In Example 1 you will have seen that there is a lot of data that 
can be entered when simulating an exchanger.  To design an 
exchanger requires much less data.  For all calculation types  
you can reduce the amount of input you must consider by using 
Basic Input Mode.

1. Select Open from the File menu and select example 
QPFD1.PFE1.  As this is a design case you will initially be 
shown the Process input (as shown in Figure 1.7 for the 
previous example).

2. Open the Start up screen by selecting Start up from the 
Input menu.  

The Start up screen is also shown whenever you create a new 
file. It is here where you must specify the type of calculation 
that UniSim® PFE will perform. Notice that this is a Design 
case.   

3. Check the Basic Mode check-box. Then, select OK. 

 Figure 1.12

All the main input screens have keyboard short-cuts. For 
instance the Start up screen is <SHIFT>+<F1>; Physical 
Properties Data is <SHIFT>+<F12>.
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1-14 Example 2
You will now see the Process Geometry form again as shown 
in Figure 1.13. Notice that the amount of information displayed 
on the form has reduced, and that the view now has only one 
tab instead of three. This reduction of input fields is applied 
throughout the main input forms.

4. Look for Geometry under the Input menu.  You will find it 
is greyed out.  This is because in Design mode there is no 
need to specify any Geometry input.  

5. If you go back to Start up under the Input menu, switch off 
Basic mode, and press OK, you will find you can access the 
Geometry input.  Note that nearly all the items are blank.

If you Run this case, then look at the Output menu, you will 
see that the Exchanger Diagram can be requested.  See 
Figure 1.14.  This diagram is based on the results of the 
calculation, whereas the diagram shown when the previous 
example (UniSim® PFE Simulation) was started reflected the 

 Figure 1.13
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input data initally supplied.

This concludes the UniSim® PFE Getting Started section. 
Continue examining UniSim® PFE Input and Output options on 
your own, or examine any of the other sample cases. Once you 
have completed your UniSim® PFE session, simply select the 
Exit icon or Exit from the File menu to close UniSim® PFE.

 Figure 1.14

Exit Icon
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2  QA Examples

A set of seven sample UniSim® PFE cases, including both input and 
output files are provided with UniSim® PFE for Quality Assurance (QA) 
purposes. As a check that you have installed UniSim® PFE correctly, 
you should run the input files and compare your results files with those 
provided.

UniSim® PFE files have a file extension .PFEx (where x is an indicator 
of the type of file (input or one of the various outputs). A full listing is 
given in the  Help Text. 

On installation, the QA files are stored in a subdirectory QADATA of the 
directory containing the main UniSim® PFE folder. The sample cases 
have file names QPFE1, QPFE2 and QPFD1, and file extensions .QAx 
instead of .PFEx. The different extensions are used to ensure that you 
cannot accidentally overwrite the QA files when running UniSim® PFE.

Copies of the QA input files, with the standard input file extension .PFE 
are also put in the \UniSim Heat Exchangers Rxxx\UniSim 
PFE\Samples directory by the installation procedure.

2.1 Creating Output for 
Comparison

Using the QPFE1 example, a typical check on UniSim® PFE installation 
would be as follows:

1. Copy the QPFE1.QAI file from the \UniSim Heat Exchangers 
Rxxx\UniSim PFE\QADATA directory to some other directory, for 
example \My Documents\My Heat Exchanger Cases.

2. Rename the file, and give it the extension .PFE for example 
MYTEST1.PFE.

3. Start UniSim® PFE, you will see the opening screen, click on 
Existing and select \My Documents\My Heat Exchanger 
Cases\MYTEST1.PFE.

4. Run UniSim® PFE with this case.

5. Compare the results files from your run with the results files 
supplied with UniSim® PFE.

6. Checks may be repeated with the other QA files supplied.
2-1
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2.2 Comparing Outputs
Your calculated results are files named MYTEST1.PFEx, in directory 
\My Documents\My Heat Exchanger Cases and these need to be 
compared with the supplied results files QPFE1.QAx in directory 
\UniSim Heat Exchangers Rxxx\UniSim PFE\QADATA.

The most important comparisons are the .PFEV and .PFEL files but 
other files can be compared as well. The .PFEV file is the Brief Output 
and is a relatively short file. You can do the comparison using a file 
difference utility, or by printing off the two files and looking for 
differences.

If the files are identical, (except for the run time and input file name 
recorded in the output), the QA check is successful. If the files differ 
slightly, but only in the fourth or fifth significant figure of one or two 
variables, the QA check on this example is also successful. If there are 
more significant differences, consult Honeywell.

 Figure 2.1

Remember, the QADATA 
files supplied with 
UniSim® PFE have the 
extension .QAx.
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